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HMS Connectors 

Ewon Real-time values 

This connector is used to get real time data from Ewon Flexy devices using the OPC UA server.  This 

requires the OPC-UA feature to be enabled in the device. 

Set up Ewon 

 
 

For real-time data access, enable OPCUA from Setup, System, Main in the web interface of the 

Ewon device. 

 

• Check Enable OPC UA Server. 

• Configure Port and Authentication settings 
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Connector 

To configure the connector to Ewon Real-time values, from the Project Explorer select Data, 

Connectors. 

• Click Add 

• Select HMS, Ewon Real-time values 

• Click OK 

 
 

The Host Name is the IP address of the Ewon Flexy. 

 

The Port number for the Ewon server can be found in the UA configuration settings. 

 

For the Server name, select the one that matches the security settings of the Ewon Flexy. 

 

Set Security Profile based on the configuration of the UA Server. 

Trusted Clients 

In some cases, the client has to be accepted by the server to make requests. Open the OPCUA page in 

the Ewon web configuration and set the client certificate to Trusted Status. 

 

Remote Communication to Ewon Flexy 

The workstation with XLReporter must also have the OPC core components installed.  To determine 

if the core components are installed verify the following file exists: 

• C:\Windows\SysWow64\OPCEnum.exe (64-bit OS) 

• C:\Windows\system32\OPCEnum.exe (32-bit OS) 

If the components are not installed then they are provided in the tools folder of the installation or from 

www.opcfoundation.org. 

 

http://www.opcfoundation.org/
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Verify Data Communication 

To verify communication to the Ewon, open the Project Explorer and select the Tools tab.  Launch 

the System Check application. 

• Click Add 

• Choose the Ewon Real-time values connector from the dropdown list. 

• Click the pushbutton ([…]) next to Items to open the Tag Browser window. 

 

• Select one or more tags, click OK. 

 

Click Start to verify the communication. 
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Ewon DataMailbox 

This connector is used to download data from an Ewon DataMailbox to a local database from which 

data can be retrieved for reporting.  Both historical and alarm data can be downloaded from the 

Mailbox and reported on. 

Set up Ewon 

Initial Setup 

For a new Ewon Flexy there is some basic configuration that has to be performed using eBuddy.  This 

is available from the HMS Networks web site. 

 

Connect the LAN Ethernet port to your PC by either using a switch (HMS does not recommend 

connecting directly via Ethernet cable) or a networked connection and start eBuddy. 

 

• In the list, select the connected Flexy device and click Set IP. 

• Follow the prompts and enter an IP/Subnet in the range of the process equipment to which 

the Flexy is intended for. 

 

The Flexy will reboot to change the IP. When it comes back online, select it again in eBuddy and click 

Open Browser. 

 

When moving onto the next step, leave eBuddy open (it can be minimized). Its ezDHCP function is 

required to remain connected if the Ewon’s IP address is outside the range of your network adapter. 

 

The eBuddy application is usually used for direct connections to the Flexy.  Once a Talk2M account 

has been associated with the Flexy, a secure internet connection can also be used. 

 

Configure a Talk2M Account 

For remote access, a Talk2M account needs to be created and associated with the Flexy. The account 

supports multiple flexy devices. When a Talk2M account is created, a DataMailbox is created 

automatically with it. This is done by eCatcher, a software application which is available from the 

HMS Networks web site. 

 

Start eCatcher and select Create a Free Account. 
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After the account is created, log into eCatcher.   

 

• Click Add eWON. Give the Ewon a name that will provide context to the data it will collect. 

• Highlight the Ewon and select Properties. Then, select Talk2M Connectivity.  

• Note the Activation Key, and the name. 

 

User Authentication 

eCatcher allows two-factor authentication for configured users – however, this will make the account 

inaccessible to Talk2M data client applications, including XLReporter. Authentication should be set 

to single-factor authentication. 
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Talk2M Connection 

From the web Interface of the Flexy, log in using the default credentials adm/adm. 

 
 

Open the Wizards page from the top-right of the window. Follow each wizard in order, starting with 

System. 

 

Once the VPN connection is established, its status is displayed on the home page, as well as in the 

lower-right corner across configuration web site: 

 
 

Configure a DataMailbox Upload 

For data to be stored in the mailbox, it must be uploaded from the Ewon device. 

 
 

This is configured from the Ewon configuration web page by selecting Setup, System, Main, Net 

Services, Data Management. 

 

Enable Historical Data and set an Upload Interval. 
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Configure Process Data Connection 

Data collection requires an I/O Server connection. 

 

• Open Tags, IO Servers from the Flexy configuration web page. 

• Enter IP and poll rate for the hardware being connected. 

 

After an IO Server is defined, Tags can be defined, which map the value of an external data point in 

the server to an internal tag in the Flexy. 

 

• Open the Tags, Values page. 

• Set Mode to Setup and click Add. 
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• Enter a Tag Name 

• Set the Server Name, Address, and data Type 

• Enable Historical Logging. 

• A tag can be logged on a timed Logging Interval and/or a value Deadband. 

• Optionally, enable Alarm Setup on the tag. 

• Repeat this process for all tags required for reporting. 

Connector 

To configure the connector to Ewon DataMailbox, from the Project Explorer select Data, 

Connectors. 

• Click Add 

• Select HMS, Ewon DataMailbox 

• Click OK 
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The Mailbox tab defines the credentials used to connect to the Mailbox as well as how often to 

download data from the Mailbox.  The Status button can be used to verify the specified credentials. 

 

Account is the Talk2M account associated with the Ewon unit(s) to be connected for reporting. 

 

User Name is defaulted to t2m-api-token as is required by the Talk2M DMWEB API. This setting 

should not be changed. 

 

Password is an API Token that has been defined in eCatcher. To define an API token in eCatcher, log 

into the application and open Account, Show Advanced Settings, API Tokens, Manage. 

 

Here, click New Token. 

 
Enter a name for the new token and click OK. Click Copy to clipboard and paste this toke in a secure 

location. This is the only time it will be available. Click Close. 

 

Once the credentials are specified, click Register Ewons to select the Ewon unit(s) from which to 

retrieve data.   

*Note that the number of Ewons that can be registered is determined by the number of OEM devices 

included in the XLReporter license. 

 

The Storage tab defines the database where the Data Mailbox data is permanently archived for 

reporting. 

 

The Sync Mailbox button can be used to initiate a download from the Mailbox to the storage database 

as well as troubleshoot any issues with any data transfer. 

 

The View Storage button can be used to view data stored to the database. 

Automated Data Sync 

The Talk2M DataMailbox is designed to store data temporarily. Therefore, XLReporter needs to sync 

new data automatically so it is not lost. This is done by the XLReporter Scheduler, which can be 

started from the Project tab of Project Explorer. 

 

 
 

Automatic Scheduler Startup 

It is recommended to configure the Scheduler to run as a Windows Service. This is configured from 

the Schedule Designer opened from the Project tab of Project Explorer. 
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In the Schedule Designer, open Scheduler, Setup and select Run as a Service. Enter the credentials 

of an administrator Windows User. 

Historical Data Retrieval 

From the local database raw values can be retrieved for any tag from any registered device that has 

uploaded data to the Mailbox.  In addition, calculations can be performed on the historical data and the 

results of those calculations added to a report. 

Tag Browsing 

The Ewon DataMailbox may collect data from multiple devices.  Using XLReporter, data from 

multiple devices can be retrieved with a single connection. 

When browsing for tags, you are presented with each device.  Select a specific device to see all the 

tags available for it. 

The syntax of each selected tag is Device:Tag Name. 

 

Alarms 

When configuring a data group for the Ewon DataMailbox connector, Alarm Values is one of the 

options.  This launches the Database Data Group builder where you can configure a query to retrieve 

alarm data.  By default, the group is populated with all the settings to query alarm history from the 

month. 

There are 2 views provided to retrieve alarm data, vw_AlarmHistory and vw_AlarmCurrent. 

Alarm History 

The vw_AlarmHistory view is used to retrieve all the alarms that have occurred.  The following 

columns are available: 

• AlarmDate – the date of the alarm record 

• eWONName – the name of the Ewon device the tag name comes from 

• TagName – the name of the tag in alarm 

• Status – the status of the alarm as text (e.g., ALM, ACK, RTN) 

• Type – the type of  alarm (e.g., High, Low, HiHi) 

 

Current Alarms 

The vw_AlarmCurrent view is used to retrieve a record for each alarm that is currently occurring.  

The following columns are available: 

• StartDate – the date the alarm started 

• StatusDate – the date when the current status of the alarm occurred 

• eWONName – the name of the Ewon device the tag name comes from 

• TagName – the name of the tag in alarm 

• Status – the status of the alarm as text (e.g., ALM, ACK, RTN) 

• Type – the type of  alarm (e.g., High, Low, HiHi) 

Custom Data 

When configuring a data group for the Ewon DataMailbox connector, Custom Values is one of the 

options.  This launches the Database Data Group builder where you can configure a query to retrieve 

data from any table(s) and/or view(s) in the database. 

This can be useful for building groups to retrieve things like Ewon device names or tag names in a 

device that can be used as part of an On Demand report to retrieve alarm information. 
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Verify Data Communication 

Open the Project Explorer and select the Tools tab.  Open Connector Groups.  Select the Ewon 

DataMailbox history connector and then select Add. 

 
Set the Group Type to Raw Values and click OK. 

 
On the Columns tab: 

• Select the first row under the Name column 

• Click the browse pushbutton (…)  

• In the Tag Browser expand Catalog, General and add Items from the lower left. 

• Click OK to add these to the group. 

To retrieve data, select Preview. In the Preview window, use the data picker to select a date and time 

with for which you have data in a csv file on the local system.  Click Refresh to view data.  The first 

60 records starting at the date and time specified should be displayed. 
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Ewon M2Web Real-time values 

This connector is used to collect most-recent values from Ewon Flexy family devices via the Talk2M 

M2Web API. 

Set up Ewon 

Initial Setup 

For a new Ewon Flexy there is some basic configuration that has to be performed using eBuddy.  This 

is available from the HMS Networks web site. 

 

Connect the LAN Ethernet port to your PC by either using a switch (HMS does not recommend 

connecting directly via Ethernet cable) or a networked connection and start eBuddy. 

 

 

• In the list, select the connected Flexy device and click Set IP. 

• Follow the prompts and enter an IP/Subnet in the range of the process equipment to which 

the Flexy is intended for. 

 

The Flexy will reboot to change the IP. When it comes back online, select it again in eBuddy and click 

Open Browser. 

 

When moving onto the next step, leave eBuddy open (it can be minimized). Its ezDHCP function is 

required to remain connected if the Ewon’s IP address is outside the range of your network adapter. 

 

The eBuddy application is usually used for direct connections to the Flexy.  Once a Talk2M account 

has been associated with the Flexy, a secure internet connection can also be used. 

 

Configure a Talk2M Account 

For remote access, a Talk2M account needs to be created and associated with the Flexy. The account 

supports multiple flexy devices. When a Talk2M account is created, a DataMailbox is created 

automatically with it. This is done by eCatcher, a software application which is available from the 

HMS Networks web site. 

 

Start eCatcher and select Create a Free Account. 
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After the account is created, log into eCatcher.   

 

• Click Add eWON. Give the Ewon a name that will provide context to the data it will collect. 

• Highlight the Ewon and select Properties. Then, select Talk2M Connectivity. 

Note the Activation Key, and the name. 

 

User Authentication 

eCatcher allows two-factor authentication for configured users – however, this will make the account 

inaccessible to Talk2M data client applications, including XLReporter. Authentication should be set 

to single-factor authentication. 

 

Talk2M Connection 

From the web Interface of the Flexy, log in using the default credentials adm/adm. 
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Open the Wizards page from the top-right of the window. Follow each wizard in order, starting with 

System. 

 

Once the VPN connection is established, its status is displayed on the home page, as well as in the 

lower-right corner across configuration web site: 

 
 

Configure Process Data Connection 

Data collection requires an I/O Server connection. 

 

• Open Tags, IO Servers from the Flexy configuration web page. 

• Enter IP and poll rate for the hardware being connected. 

 

After an IO Server is defined, Tags can be defined, which map the value of an external data point in 

the server to an internal tag in the Flexy. 
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• Open the Tags, Values page. 

• Set Mode to Setup and click Add. 

 

• Enter a Tag Name 

• Set the Server Name, Address, and data Type 

• Repeat this process for all tags required for reporting. 

Connector 

To configure the connector to Ewon M2Web Real-time values, from the Project Explorer select 

Data, Connectors. 

• Click Add 

• Select HMS, Ewon M2Web Real-time values 

• Click OK 

 
Talk2M Tab 

These settings define the account information used to connect to the Talk2M VPN. The credentials 

entered here are the same used to log into the eCatcher application or the M2WEB browser portal. 
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Settings 

Protocol can be either http or https.  If a secure connection is required, use https, otherwise use 

http. 

 

Request timeout is the number of seconds to wait for a request to complete before a timeout error 

occurs.  The default is 20 seconds. 

 

Wait before request is the number of milliseconds to wait between connecting to Talk2M and 

requesting data.  The default is 0 milliseconds. 

 

Request retries before fail is the number of times the request is retried before it is considered an 

error when the request fails.  The default is 2. 

 

Request retry interval is the number of milliseconds to wait between each retry if a request fails.  

The default is 100. 

 

Devices Tab 

 

 

This tab is used to associate one or more Ewon Flexy devices with the Data Connector. Click Add 

to open Device Setup. 

 

Device Setup 

 

To set up a device, click Scan for devices.  This returns a list of the Flexy devices associated with the 

Talk2M account specified in the Talk2M tab. 
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Location is used to help document the device.  It is an optional setting. 

 

The Login User and Login Password must be accepted by the specific device. 

 

Once the settings are specified, click Verify device to connect and retrieve the most recent values for 

all available tags. 

Data Limits 

Note that the frequency at which the M2WEB interface can be queried by applications like 

XLReporter is limited by the terms and conditions of the Talk2M platform. 

 

Verify Data Communication 

To verify communication to the Ewon, open the Project Explorer and select the Tools tab.  Launch 

the System Check application. 

• Click Add 

• Choose the Ewon M2Web Real-time values connector from the dropdown list. 

• Click the pushbutton ([…]) next to Items to open the Tag Browser window. 

 

• Select one or more tags, click OK. 
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Click Start to verify the communication. 
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Ewon On-Premise Tag History 

Prerequisites 

• Ewon Flexy device with historical logging configured 

• LAN connection from XLReporter computer to the Flexy device 

Setup: Ewon Flexy 

File Directory 

It is recommended to create a directory on the flexy’s file system to store historical data files. 

 
 

Open Windows File Explorer and navigate to ftp://[ewon ip]/usr. 

Right-click and select New Folder. 

Create the folder history.  

BASIC Script 

The general approach is to schedule the export automatically on a timed basis to a set of files using the 

date/time to name the files. In this example, the export is performed daily, at midnight, and exports the 

previous 1 day of history to a file named after the date, e.g., 2021_12_16.txt representing the date 

December 16th, 2021. This architecture allows the data to be accessed using the Text Historian 

connector in XLReporter. To enable the above configuration in the Ewon Flexy device, copy the below 

script into the BASIC IDE accessed from the Flexy’s web page. The script must be RUNNING to 

export data automatically. 

 

 

ftp://[ewon/
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INIT Section: 

ONDATE 1, "0 0 * * *", "GOTO EXPORT_HISTORY" 

 

User-Defined Section: 

EXPORT_HISTORY: 

sDT$ = TIME$ 

sDAY$ = sDT$(1 To 2) 

sMONTH$ = sDT$(4 To 5) 

sYEAR$ = sDT$(7 To 10) 

sPATH$ = "/usr/history/" + sYEAR$ + "_" + sMONTH$ + "_" + sDAY$ + ".txt" 

WRITEEBD "$dtHT$ftT$st_d1$et_d0$", sPATH$ 

END 

 

Connector 

To configure the connector to Ewon On-Premise Tag History, from the Project Explorer select 

Data, Connectors. 

• Click Add 

• Select Text File, Text Historian 

• Click OK 

 

File Transfer Settings 

To transfer the log files automatically from the Flexy, check Enable File Transfer.  Click Settings to 

configure. 

 

For Transfer Configuration, click the browse pushbutton (…). 
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Under the Server tab,  

 
In Transfer, set Source based on the previous network configuration. 

Set Method to Download. 

Click Servers to define an FTP Server connection. 

 
To define a new FTP Server, select the Friendly Name column of the next available row in the list and 

click the browse pushbutton (…). 

 

For the FTP Server, 

 
Set Friendly Name to a name that reflects the Flexy. 

For Server, set Server(FTP) to the IP Address of the Flexy. 

For Logon Information enter a user Name and Password to log in to the Flexy. 

Click Test FTP Server to verify the configured settings for the server. 
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Click OK to return to the list of FTP Servers. 

With the server row selected, click OK again to return to File Transfer. 

 
The FTP settings should now be filled out. 

Select the Source tab to specify the Folder containing the log files. 

 
The Folder section defines the source file path. Set this to the /usr/history directory on the Flexy. 

The Filter section determines which files are transferred.  At a minimum the Name should be set to 

*.txt (the file extension created by the WRITEEBD function in the Flexy BASIC script) to ensure that 

files with the .txt extension are transferred. 

The Target tab defines the local archive path and overwrite behavior. 
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Overwrite defines behavior when a source file already exists in the target path.  Set this to Size 

Change to overwrite only when the source file contains different content than the target. 

Click OK to save this configuration.  An initial download runs automatically. 

 
Set the Transfer Schedule based on the configuration of the BASIC script. 

Click OK to return to the connector settings. 

 

File Location and Name 

The values are defaulted based on the latest file transferred from the Flexy. In File Name Format, 

characters like YYYY, MM and DD, etc. indicate date and time expressions in the file names. In the 

example BASIC script described in this document, the file name should be YYYY_MM_DD.txt. 

 

Click View Latest to test the connection to the historical files. 

 

When the file is generated, the column names contain quotation marks which is not supported by the 

driver used by XLReporter. In addition, the timestamp format is not compatible. 
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Open File Settings to specify the following information: 

 
[xlreporter] 

; the row containing the headers (=0 custom) 

HeaderRow=1 

 

; the row containing the first set of data 

DataRow=2 

 

[consolidated.csv] 

Format=Delimited(;) 

DecimalSymbol=. 

ColNameHeader=True 

DateTimeFormat=dd/MM/yyyy hh:nn:ss 

 

; Custom Headings 

Col1=TimeInt Long 

Col2=TimeStr DateTime 

Col3=[first tag name in file] [first tag data type] 

… 

ColN=[last tag name in file] [last tag data type] 

 

Where Tag1 through TagN are the tag names from the flexy. Note the required definition of the 

timestamp. 

 

Click OK to return to Text Historian (time series). 

 

File Content  

These settings define date/time indexing in the files as well as the value separator which are 

determined from the files themselves. For Ewon Date Column is the TimeStr column, and Date 

Includes Time is enabled. Separator is Semicolon. 

 

Click OK to return to New Project. Click Finish to deploy the project. 

 

Verify Data Communication 

Open the Project Explorer and select the Tools tab.  Open Connector Groups.  Select the Flexy 

history connector and then select Add. 

 
Set the Group Type to Raw Values and click OK. 
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On the Columns tab: 

• Select the first row under the Name column 

• Click the browse pushbutton (…)  

• In the Tag Browser expand Catalog, General and add Items from the lower left. 

• Click OK to add these to the group. 

To retrieve data, select Preview. In the Preview window, use the data picker to select a date and time 

with for which you have data in a csv file on the local system.  Click Refresh to view data.  The first 

60 records starting at the date and time specified should be displayed. 
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Information in this document is subject to change without notice.  SmartSights, LLC assumes no 

responsibility for any errors or omissions that may be in this document.  No part of this document may be 

reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without 

the prior written permission of SmartSights, LLC. 
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